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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce
chapitre. Pour une liste plus détaillée, voyez dans 'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acces aux options de paramétrage
Outils > Options

Clic droit 3 +clic Ouvre un menu contextuel
Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches
F5 Maj+38+F5 Ouvre le Navigateur

F11 F+T Ouvre la fenétre Styles & Formatage
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Barres d'outils et menus

Pour modifier les attributs d'un objet, comme sa couleur ou la largeur de sa bordure par exemple,
vous pouvez utiliser la barre d'outils Ligne et remplissage, la barre d'outils Formatage du texte ou
le menu contextuel d'un obijet.

Barre d'outils Ligne et remplissage

Si la barre d'outils Ligne et remplissage (Figure 1) n'est pas affichée, allez dans Affichage >
Barres d'outils > Ligne et remplissage. Les attributs les plus usuels d'un objet peuvent étre
modifiés au moyen de cette barre d'outils. Vous pouvez accéder a des informations
supplémentaires en cliquant sur l'icbne Ligne pour accéder a la boite de dialogue Ligne, ou en
cliquant sur I'icbne Remplissage pour accéder a la boite de dialogue Remplissage.

Ligne et remplissage * X

= ﬁ b 0,00ecm % ‘- Mair |E” a |C|:uuleur IZID [1 Izl = | & - [”@' -

Figure 1 : Barre d'outils Ligne et remplissage

Les outils disponibles dans cette barre d'outils, de gauche a droite, sont listés Figure 2.

|#1| Styles et formatage Ombre
T Image Map
Style de fleche Effets
Retourner

Style de ligne

Position et taille

L deli
e Alignement

Couleur de ligne

HEF 2@ 5D

Disposer

Rernplissage

98 E=EE 0

Style de remplissage

Figure 2 : Outils de la barre d'outils Ligne et
remplissage

Barre d'outils Formatage du texte

Lorsque vous sélectionnez un texte, la barre d'outils Ligne et formatage est remplacée par la barre
d'outils Formatage du texte (Figure 3). Vous pouvez également la faire apparaitre en choisissant
Affichage > Barres d'outils > Formatage du texte. Les outils de cette barre d'outils ne seront
disponibles que lorsqu'un texte aura été sélectionné.

Fo»-rmatage du texte V-X
Avial o [[] 6 1S m[=s]= K lx A A-§
Figure 3 : Barre d'outils Formatage du texte
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Les outils disponibles dans cette barre d'outils, de gauche a droite, sont listés Figure 4.
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Mom de police Interligne: 1

Taille de police M T

Interligne: 2
Gras
Italique (Dés)activer les puces
Soulignage Agrandir la police
Ornbre Réduire la police

Orientation du texte de gauche 2 droite

3 SR

Aligner & gauche

Centré ||&  Orientation du texte de haut en bas
Aligner & droite Caractére
Justifié Paragraphe

Ce gauche & droite Couleur de police

De droite 3 gauche Caractéres spéciaux

@ EE

Augrnenter |'espacement

Béduire I'espacement

G &t MWmm FMNE B =

Figure 4 : Outils de la barre d'outils Formatage du texte

Menu contextuel d'un objet

Ligne...
Remnplissage...
Texte...

Position et taille...

Caractére...

2% % 9=

Paragraphe...

Organiser Envoyer & I'avant
Alignement
Refléter

Conwertir

Enwoyer vers 'avant

Enwoyer vers |'arriere

v v v

od BT D

Enwvoyer a I'arrigre
Description...

Meom... Devant I'cbjet

Derriere |'chjet

Editer le style d'objet...

&2 Couper
g Copier
Figure 5 : Menu contextuel d'un objet

Lorsque vous sélectionnez un objet et que vous faites un clic droit, un menu contextuel s'ouvre
(Figure 5). Ce menu vous permet d'accéder a des commandes destinées a modifier les attributs de
I'objet sélectionné. Les éléments du menu qui comportent un petit triangle noir a leur droite
donnent accés a un sous-menu.

Barres d'outils et menus 7



Formater des lighes

Dans LibreOffice, le terme de ligne s'applique a un segment indépendant (ligne), au bord extérieur
d'une forme (bordure) ou a une fleche. Dans la plupart des cas, les propriétés d'une ligne que vous
allez modifier sont son style (continu, tirets, pointillés, invisible...), sa largeur et sa couleur.

Attention

LAY
4

L'outil Largeur permet de définir I'épaisseur du trait. Ne pas confondre avec la
largeur (longueur du trait) définissable dans le dialogue Position et taille.

Vous pouvez effectuer rapidement les modifications en sélectionnant la ligne et en utilisant les
outils de la barre d'outils Ligne et remplissage (Figure 6).

Ligne et remplissage * X
b - 000cm |+ A |coveur [~] -] =

Figure 6 : Style, largeur et couleur d'une ligne

Si vous avez besoin de régler plus finement les attributs d'une ligne, vous pouvez le faire dans la
boite de dialogue Ligne. Pour y accéder, sélectionner la ligne et choisissez Format > Lignhe dans

la barre de menus, cliquez sur l'icbne Ligne & de la barre d'outils Ligne et remplissage, ou faites
un clic droit et choisissez Ligne dans le menu contextuel. La boite de dialogue Ligne comporte
quatre onglets : Ligne, Ombre, Styles de lignes et Styles de fleches. L'onglet Ombre n'est pas
accessible pour les bordures de formes : vous pouvez y accéder a partir de la commande
Remplissage.

Ligne ==

Ligne |Gmbre|5t_~,r|es de lignes |5t_~,r|es deflér_hes|

Propriétés de la ligne Styles de fleche

Style Style

|— Continu |Z| |-I— Fleche |Z| |—. Carré |Z|

Couleur Largeur

/Ml Noir - 0,20cm z 0,20cm :

Largeur [ Centre [T] Centre

0.00cm = O Synchroniser les extrémités

Transparence Styles d'angle et de coiffe

0% z Style d'angle Style d'extrémite
|Arr|:|r1di |Z| |F'Iat |Z|

< VAN

| K || Annuler || aide || Reinitialiser

Figure 7 : Onglet Ligne
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Propriétés de la ligne

L'onglet Ligne (Figure 7) est I'endroit ou sont gérés les paramétres de base d'une ligne. Il est
divisé en quatre sections.

Section Propriétés de la ligne

Style
Plusieurs styles de lignes sont disponibles dans la liste déroulante (Figure 8). Des styles
supplémentaires peuvent étre définis si nécessaire : voir "Styles de lignes" page 11.

Style

Continu

sensmsssnsaaasne Tiret ultra-fin

— —— Tiretfin

—————— 3 Tirets 2 points ultra-fins
Point fin

——————— Ligne avec points fins

................ Tiret fin (var)

s i 3 Tirets 3 points (var)

e Pyints ultra-fins (var)

[ — Style de ligne @

-« = -« = 1Tiret2 points

[— Tiret (var)

Figure 8 : Styles de ligne

Couleur
Choisissez une couleur parmi les couleurs prédéfinies dans la liste déroulante.

Largeur
Saisissez la largeur de la ligne souhaitée. L'unité de mesure par défaut est celle indiquée dans
Outils > Options > LibreOffice Draw > Général, mais vous pouvez saisir une autre unité. Si
cette valeur est nulle, la ligne résultante a une largeur minimale d'un pixel.

Transparence
Saisissez le pourcentage de transparence de la ligne. La Figure 9 montre I'effet de différents
pourcentages de transparence lorsque des lignes sont placées au-dessus d'un objet.

Figure 9 : Différentes valeurs de
transparence (0%, 25%, 50% et
75%, de gauche a droite)

Section Styles de fleche

Les paramétres de la section Styles de fleche ne s'appliquent qu'aux lignes individuelles et n‘ont
aucun effet sur les lignes qui constituent la bordure d'une forme.

Formater des lignes 9



Style
Choisissez le style des deux extrémités de la ligne. La liste déroulante de gauche vous permet
de choisir le style du début de la ligne et la liste déroulante de droite de choisir le style de la fin
de la ligne.

Vous pouvez modifier plus rapidement le style d'une extrémité de la ligne en utilisant I'icone

Style de fleche “ de la barre d'outils Ligne et remplissage et en choisissant un style dans la
barre d'outils Extrémités de fleche (Figure 10), a gauche pour le début et a droite pour la fin de
la ligne.

Extrémités de f... =

e

m

-

HYAATt TN
LeWVuw# [ Vay|l

Figure 10 : Barre d'outils Extrémités de fleche

Attention . . B , . " -
? L'option Synchroniser les extrémités ne s'applique pas si vous utilisez I'icbne Style

de fleche.

Largeur
Saisissez les largeurs de fleche souhaitées aux deux extrémités de la ligne, si un style de
fleche a été choisi. L'unité de mesure par défaut est celle indiguée dans Outils > Options >
LibreOffice Draw > Général, mais vous pouvez saisir une autre unité. Si cette valeur est nulle,
la fleche disparaitra.

Centre
Déplace le centre de la fleche de I'extrémité correspondante vers le point d'extrémité (a
I'endroit ou la ligne se termine). La Figure 11 montre |'effet de cette option.

P
& -

Figure 11 : Fléches par défaut
(en haut) et centrées (en bas)

Synchroniser les extrémités
Une fois cette option cochée, si vous modifiez un attribut d'une extrémité dans cette section,
I'attribut correspondant de l'autre extrémité de la ligne sera modifié de la méme facon.

Formater des lignes 10



Attention Le simple fait de cocher l'option Synchroniser les extrémités ne va pas rendre
identique les deux extrémités de la ligne. Il faut que vous modifiiez un attribut pour
que ses valeurs soient identiques pour le début et la fin de la ligne.

Section Style d’'angle et de coiffe

Le style d'angle détermine la fagon dont s'effectue la jonction entre deux segments. Les styles
Arrondi, - aucun -, En onglet et Biseauté sont disponibles. Pour comprendre la signification des
différents styles d'angle, augmentez la largeur de la ligne et observez leur effet dans I'apercu de la
ligne.

Le style d'extrémité détermine la forme des extrémités de chaque ligne. Les styles Plat, Arrondir et
Carré sont disponibles. Procédez comme pour les styles d'angle pour comprendre leur
signification.

Section Apercu

Cette section, située en base de la boite de dialogue, vous permet d'avoir un apercu de la ligne et
de ses styles d'angle et d'extrémité, au fur et & mesure que vous modifiez les paramétres de
l'onglet Ligne.

Ombre

L'onglet Ombre (Figure 12) est I'endroit ou vous pouvez ajouter et formater une ombre a la ligne
sélectionnée. Le contenu de cet onglet est identique a celui s'appliquant aux objets et est décrit
dans "Ombre" page 19.

Ligne @

Ligne|Ombre [Styles de lignes |Styles de fléches

Proprigtés

o Bppliguer 'ombre:

Position ‘T r ‘T I
" T "
I I
T T »

Distance 0,20cm =

Couleur |. Gris |Z||

Transparence 0% =

Figure 12 : Onglet Ombre

Vous pouvez appliquer rapidement une ombre a la ligne sélectionnée en utilisant Iicbne Ombre

i de la barre d'outils Ligne et remplissage. Cependant, 'ombre appliquée ne sera que celle
définie par défaut.

Styles de lignes

L'onglet Styles de lignes (Figure 13) est I'endroit ou vous allez pouvoir créer de nouveaux styles de
ligne et charger des styles préalablement enregistrés. Il est préférable de créer de nouveaux styles
plutét que de modifier des styles prédéfinis.

Formater des lignes 11



Ligne @

Ligne |Ombre | Styles de lignes Styles de fleches

Propriétes

Style de ligne | ----------- Tirets ultra-fins IZ” | Ajouter... |
Type [Tiret (=] [vire =] | Modifier.. |
Mombre 1 =1l |1 =
o | Supprimer... |
Longueur 0.05cm > |0,05cm =
Espacement 0,05cm = |

Adapter a la largeur de |a ligne |_

8

Figure 13 : Onglet Styles de lignes

Créer un style de ligne
Pour créer un style de ligne a partir de cet onglet :
1) Choisissez dans la liste déroulante Style de ligne un style proche de celui que vous voulez
créer.

2) Cliquez sur Ajouter. Dans la boite de dialogue Nom qui s'ouvre, saisissez le nom du
nouveau style de ligne et cliquez sur OK.

3) Définissez le nouveau style. Commencez par choisir le type de composant de la ligne
(Point ou Tiret). Vous pouvez alterner ces composants en choisissant deux types
différents dans les deux zones du type de ligne.

4) Saisissez le nombre et la longueur de chacun des composants de la ligne. La longueur
n‘est pas disponible pour un composant de type Point.

5) Saisissez lI'espacement entre les différents composants.
6) Vous pouvez cocher I'option Adapter a la largeur de la ligne.

Le nouveau style de ligne ainsi créé n'est disponible que dans le document en cours. Si vous

voulez l'utiliser dans d'autres documents, cliquez sur l'icbne Enregistrer les styles de lignes =
et saisissez un nom de fichier dans la boite de dialogue Enregistrer sous qui s'ouvre. Le fichier a
une extension .sod et comprend la liste active des styles de ligne.

Pour utiliser des styles de ligne préalablement enregistrés, cliquez sur l'icbne Charger les styles

de ligne E et sélectionnez un fichier dans la boite de dialogue Ouvrir qui s'ouvre. Cliquez sur
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de ligne.

Formater des lignes 12



Styles de fleches

L'onglet Styles de fleches (Figure 14) est I'endroit ou vous allez pouvoir créer et modifier des styles
de fléche et charger des styles préalablement enregistrés.

Ligne

=]

|Ligr1e |Gmbre|5ty|es de Iignes|5‘f}f|es defléches

Gérer les styles de fleches

Titre Fleche [ Ajouter.. ‘
Style de fleche I Modifier... ‘
B— Carré [ I Supprimer.. ‘

Ajoutez un objet sélectionné pour créer de nouveaux styles de fleche,

4—p NN

-aml}- Fleche étroite

—— Lignes de cotation
+— Double fleche

o}— Fleche courte arrondie
#— Fléche symétrique
= — Ligne fléchée *

@| (s

Figure 14 : Onglet Styles de fléches

Créer un style de fleche
Pour créer un style de fleche a partir de cet onglet :

1) Dessinez tout d'abord la forme que vous voulez utiliser comme pointe de fléche. Le
sommet de la forme doit se trouver vers le haut, comme Figure 15, parce qu'il va devenir la
pointe de la fleche.

Figure 15 : Utiliser une forme
comme pointe de fleche

2) Sélectionnez la forme et, si nécessaire, convertissez-la en courbe avec Convertir > En
courbe. Si la forme est déja une courbe, la commande ne sera pas disponible.

Note

La pointe de fleche doit étre une courbe, c'est-a-dire quelque chose que vous pouvez
tracer sans lever le crayon du papier. Par exemple, une étoile 7 peut étre une

courbe, mais une frimousse @ ne peut pas I'étre. Le bouton Ajouter ne sera pas
actif si I'objet sélectionné n'est pas du bon type.
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3) Dans l'onglet Styles de fleches, cliquez sur le bouton Ajouter, saisissez le nom du nouveau
style de fleche et cliquez sur OK. Le nouveau style de fleche va s'afficher dans I'apercu en
bas de la boite de dialogue.

Vous pouvez alors choisir ce style de fleche dans la liste déroulante.
Le nouveau style de fléeche ainsi créé n'est disponible que dans le document en cours. Si vous

voulez l'utiliser dans d'autres documents, cliquez sur I'icdbne Enregistrer les styles de fleche =l
et saisissez un nom de fichier dans la boite de dialogue Enregistrer sous qui s'ouvre. Le fichier a
une extension .soe et comprend la liste active des styles de fléche.

Pour utiliser des styles de fleche préalablement enregistrés, cliquez sur l'icbne Charger les styles

de fleche et sélectionnez un fichier dans la boite de dialogue Ouvrir qui s'ouvre. Cliquez sur
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de fleche.

Formater le remplissage

Le terme de remplissage fait référence a l'intérieur d'un objet, qui peut étre d'une couleur uniforme,
en dégradé, avec un motif de hachure ou constitué d'une image bitmap (Figure 16). Le
remplissage d'un objet peut étre partiellement ou totalement transparent et projeter une ombre.

Couleur
Dégradé

Hachure
Bitmap

Figure 16 : Différents types de remplissage

La barre d'outils Ligne et remplissage (Figure 17) contient les outils le plus habituellement utilisés
pour formater des objets. Sélectionnez tout d'abord un objet. Choisissez ensuite un des types de
remplissage (Figure 18), puis, dans la liste déroulante de droite, choisissez un remplissage
prédéfini.

Ligne et remplissage

w
E) 0 = [——1] omen 5] WMo [2] & oo Taes 7] @

Figure 17 : Type et remplissage d'un objet

Dégradé
Hachure

Bitrnap
Figure 18 : Types de remplissage
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Si vous avez besoin de régler plus finement les attributs de remplissage d'un objet, vous pouvez le
faire dans la boite de dialogue Remplissage. Pour y accéder, sélectionner I'objet et choisissez

Format > Remplissage dans la barre de menus, cliquez sur l'icbne Remplissage a de la barre
d'outils Ligne et remplissage, ou faites un clic droit et choisissez Remplissage dans le menu
contextuel. L'onglet Remplissage vous permet d'appliquer des remplissages prédéfinis, fournis par
LibreOffice ou créés par vous ou d'autres utilisateurs. Les onglets Couleurs, Dégradés, Hachure et
Bitmap vont vous permettre de créer vos propres remplissages.

Onglet Remplissage

Pour appliquer un remplissage, choisissez tout d'abord le type de remplissage dans la liste
déroulante du haut. Ce choix va modifier le contenu de l'onglet.

Choisissez le type Aucun(e) pour obtenir un objet vide.
Un apercu est disponible en bas de la boite de dialogue et va refléter les choix que vous avez
effectués.

Couleur

Remplissage |Gr'r1bre |Tran5parence|Cc-uIeurs|Dégradés|HachurE|Bitmaps|

Remplir
|C|:|uleur IE”
-

[ Turquoisel
B Turquoise 2
B Turquoise 3
[ Turquoise 4
B Turquoise s
B Turquoise6
M Turquoise7
B Turquoise
B Vertl

B Vert2

P Vert 3 i

m

Figure 19 : Remplissage de type Couleur

Sélectionnez une couleur dans liste déroulante des couleurs disponibles (Figure 19). Cliquez sur
OK pour que la couleur choisie devienne la couleur de remplissage de I'objet sélectionné.
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Dégradé

Remplissage |Gm|;}re|Transparenr_e |Couleurs |Dégradés|Hachure |Bitr‘nap5|

Remplir Pas

Dégradé v | Automatique

[P Degradél -
I C:grade?

L Dégradé s

[ | Dégradé 4

I D:gradés

™ Degradés

I Lincaire bleu/blanc
B Radial vert/noir

[ Rectangulaire rouge/blanc
[ ] Carré jaune/blanc

I Lincaire violet/vert

[ 1 Linéaire jaune/marron i

Figure 20 : Remplissage de type Dégradé

m

Choisissez un dégradé dans liste déroulante des dégradés disponibles (Figure 20). Si vous
décochez I'option Automatique, vous pouvez choisir le nombre de pas (incréments) du dégradé,
comme l'illustre la Figure 21. Cliquez sur OK pour que le dégradé choisi devienne le dégradé de
remplissage de I'objet sélectionné.

Figure 21 : Dégradé automatique (de pas 64) a gauche
et de pas 4 a droite
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Hachure

Remplissage |Gmbre |Trar15p-arer1ceICouIeurleégradés |HachurE|Bitmaps|

Remplir

|Hachure

[=]

E Moir 0 degre

[ Moir 45 degrés
Foms] Moir -45 degrés
[[m]]]] Moir 30 degrés

[

i Rouge double incling 45 degrés

Rouge double incling 0 degré
Bleu double incling 45 degrés
Bleu double incling O degré
BEEH Bleu triple incliné 30 degrés
[ 7| Moir45 degrés de largeue

Figure 22 : Remplissage de type Hachure

Couleur d'arriére plan

O Turquoise 1
B Turquoise 2
E Turquoise 3
O Turquoise 4
B Turquoise 5
B Turquoise 6
B Turquoise 7
B Turquoise

B vertl
B Vert? -

]

/)

Figure 23 : Hachure sans couleur de remplissage a gauche

et avec une couleur de remplissage jaune a droite

Sélectionnez une hachure dans liste déroulante des hachures disponibles (Figure 22). Par défaut,
l'option Couleur de remplissage est décochée et vous pouvoir voir par transparence a travers les
hachures. Vous pouvez cocher cette option et choisir une couleur d'arriére-plan dans la liste
déroulante (Figure 23). Cliquez sur OK pour que la hachure choisie devienne la hachure de
remplissage de I'objet sélectionné.
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Image Bitmap

Remplissage |5
Remplissage |Grn|:}re |Transparence|CouIeurs|Dégradés|Hachure|Bitmaps|
Remplir Taille
|Bitr‘nap |Z|| V] QOriginal Largeur
Yide - EElatlf Ha|_|tE|_||'
Ciel
Bl rau Pesition
B Gros grain = fl‘—f"—f'l“
B Cosmos co&
B Métal A A o~ A
- Gouttelettes
Markre Décalage X 0% =
e T.'F'T L.
m&i - Décalage ¥ 0% =
Mercure luxtapu:us.er Adapter automati
BEE Gravier e
Ay sapmg  Decalage
ngj I -"‘E‘“’I' i) Ligne
HROH i '
'+ i::li e 3 i.ﬁ:! ") Colopne 0% 4
T.l :l ET.I E
[P Lo o e

Figure 24 : Remplissage de type Bitmap

Sélectionnez une image bitmap dans liste déroulante des images disponibles (Figure 24). Des
paramétres de taille, de position et de décalage sont disponibles et sont décrits Tableau 1. Cliquez
sur OK pour gue l'image bitmap choisie devienne I'image de remplissage de I'objet sélectionné.

Tableau 1. Propriétés du remplissage de type bitmap

Propriété Signification
Taille — Original Conserve la taille d'origine de l'image bitmap.
Taille — Relatif Permet de redimensionner l'image relativement a I'objet.

Taille — Largeur

Largeur de l'image. Si Relatif est coché, une largeur de 100 %
indique que lI'image aura la méme largeur que I'objet qu'elle remplit.
Une largeur de 50 % indique que l'image aura une largeur deux fois
moindre que l'objet.

Taille — Hauteur

Hauteur de l'image. Si Relatif est coché, une hauteur de 100 %
indique que l'image aura la méme hauteur que I'objet qu'elle remplit.
Une hauteur de 50 % indigue que l'image aura une hauteur deux fois
moindre que l'objet.

Position — Carte d'ancrage

Indique a quel point de I'objet I'image sera ancrée.

Position — Juxtaposer

Si Juxtaposer est coché, I'image sera juxtaposée pour remplir la zone
et aura la taille indiquée dans la section Taille.

Position — Décalage X

Si Juxtaposer est coché, indique en pourcentage le décalage en
largeur de I'image bitmap. Une valeur de 50 % indique que le milieu
de la largeur de l'image bitmap est placé au point d'ancrage et que la
juxtaposition continue ainsi.

Formater le remplissage
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Propriété

Signification

Position — Décalage Y

Si Juxtaposer est coché, indique en pourcentage le décalage en
hauteur de I'image bitmap. Fonctionne comme Décalage X.

Position — Adapter
automatiqguement

Etire l'mage pour remplir toute la zone de I'objet. Les paramétres de
taille sont alors ignorés.

Décalage — Ligne

Si Juxtaposer est coché, décale les lignes paires du pourcentage
indiqué a coté.

Décalage — Colonne

Si Juxtaposer est coché, décale les colonnes paires du pourcentage
indiqué a coté.

La Figure 25 montre quelques exemples de remplissage de type bitmap avec les propriétés

utilisées.
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Figure 25 : Exemples de remplissage de type bitmap
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Ombre

Les ombres peuvent étre appliquées aux lignes, aux formes et au texte.
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Adapter automatiqguement

Juxtaposer

Taille originale

Ancrer en haut a gauche
Pas de décalage

Juxtaposer
Taille originale
Ancrer au milieu
Pas de décalage

Juxtaposer

Taille relative

Largeur 30 % hauteur 20 %
Ancrer en haut & gauche
Pas de décalage

Juxtaposer

Taille relative

Largeur 30 % hauteur 20 %
Ancrer en haut a gauche
Ligne décalée de 30 %
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Vous pouvez appliquer rapidement une ombre a I'objet sélectionné en utilisant I'icbne Ombre .
de la barre d'outils Ligne et remplissage. Cependant, 'ombre appliquée ne sera que celle définie
par défaut. Pour bénéficier de plus d'options, utilisez I'onglet Ombre de la boite de dialogue

Remplissage (Figure 26).

Cochez l'option Appliquer 'ombre pour accéder aux propriétés de I'ombre portée sur I'objet
sélectionné.

Remplissage @

Remiplissage| Ombre Transparence | Couleurs |Dégradés |Hachure |Bitmaps

Proprigtés

o Bppliguer 'ombre:

Position ‘T r ‘T I
" T "
1 I
T T »

Distance 0,20cm

Couleur & Gris |Z|

Transparence 0% =

Figure 26 : Onglet Ombre

Position
Permet de sélectionner le point qui va indiquer la direction dans laquelle I'ombre va étre portée.

Attention . A : . o .
Si vous sélectionnez le point du milieu, aucune ombre n'est appliquée et la distance

A est réduite a 0.

Distance
Détermine la distance entre I'objet et son ombre.

Couleur
Permet de choisir la couleur de I'ombre dans la liste déroulante.

Transparence
Détermine de pourcentage de transparence de I'ombre.

Transparence

Pour régler la transparence de I'objet sélectionné, utilisez I'onglet Transparence de la boite de
dialogue Remplissage (Figure 27).

Deux types de transparence sont disponibles : la transparence uniforme et la transparence en
dégradeé.

Pour créer une transparence uniforme, cochez Transparence et saisissez le pourcentage désiré.

Pour créer une transparence en dégradé, cochez Dégradé et saisissez les parameétres du
dégradé. Une explication de ces paramétres est fournie dans "Créer des dégradés personnalisés”

page 23.
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Remplissage @

RemplissageIGmbre|TrEﬂ5parEHCE |Cou|eurs|[}égradés |Hachure|Eitmaps|

Mode Transparence
() Aucune transparence

() Transparence 50%

Linéaire |z||

Centre X 50%
Centre ¥ 50%
Angle 0 degrés =
Bordure 0% =
Yaleur initiale 0% =
Valeur finale 100% =

Figure 27 : Onglet Transparence

Modifier la transparence d'un objet

Vous pouvez également créer une transparence en dégradé pour un objet avec la souris. Pour
ceci, faites afficher la barre d'outils Mode (Figure 28).

Mode *
o v &
Figure 28 : Barre d'outils Mode

Attention S : : . .
Cette modification n'est possible qu'avec des objets de type courbe. Faites un clic
/N droit sur l'objet et choisissez Convertir > En courbe si nécessaire.

Sélectionnez un objet et cliquez sur l'icbne Transparence 3(,. L'axe du dégradé apparait en
pointillés avec, a chacune de ses extrémités, un carré de la couleur correspondante (Figure 29).
Vous pouvez alors déplacer chacun de ses points pour obtenir le dégradé que vous souhaitez. Les
valeurs des propriétés de I'onglet Transparence de la boite de dialogue Remplissage sont mises a
jour. Il n'est pas possible de déplacer le point de départ de I'axe d'un dégradé de transparence de
type Axial.

@
L=
@

Figure 29 : Effet du déplacement de I'axe du
dégradeé de la transparence
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Créer de nouveaux remplissages

Bien que vous puissiez modifier les caractéristiques d'un remplissage existant, en cliquant sur le
bouton Modifier, il est recommandé de créer de nouveaux remplissages, et de ne modifier que les
remplissages personnalisés et non les remplissages prédéfinis. Cela vous évitera de voir vos
modifications écrasées lors d'une mise a jour de LibreOffice.

Vous pouvez enregistrer la liste des remplissages d'un type donné avec l'icbne = , Enregistrer la
liste des dégradés par exemple, afin de pouvoir utiliser un remplissage que vous venez de créer
dans un autre document. La boite de dialogue Enregistrer sous s'ouvre, 0U VOUS pouvez saisir un
nom de fichier.

Pour utiliser une liste de remplissage préalablement enregistrée, utilisez I'icbne , Charger la
liste des dégradés par exemple, et sélectionnez le fichier dans la boite de dialogue Ouvrir.
Cliquez sur OK et la liste des remplissages sera disponible dans votre document.

Créer des couleurs de remplissage personnalisées

Vous pouvez créer des couleurs personnalisées, ou modifier des couleurs existantes, dans l'onglet
Couleur de la boite de dialogue Remplissage (Figure 30).

Remplissage |25

|Remplissage |Gr‘nbre |Transparence|':DLI|ELlr5 |Dégradé5|Hachure |Bitmaps|
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Figure 30 : Créer une couleur de remplissage

Vous pouvez définir une couleur en spécifiant ses attributs RVB (Rouge, Vert, Bleu) sur une
échelle de 0 a 255, ou CMJN (Cyan, Magenta, Jaune, Noir) de 0 a 100 %. Saisissez les valeurs
correspondant a la couleur désirée.

Pour créer une nouvelle couleur, saisissez son nom. Spécifiez les attributs selon le systéme de
couleur que vous avez choisi. Cliquez enfin sur Ajouter. La couleur est ajoutée dans la liste
déroulante et dans la table standard.
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Pour modifier une couleur, sélectionnez-la dans la liste déroulante ou dans la table standard.
Spécifiez ses nouveaux attributs, puis cliguez sur Modifier.

Vous pouvez également, aprés avoir choisi une couleur, cliquez sur le bouton Editer. La boite de
dialogue Sélecteur de couleur s'ouvre (Figure 31).

-

Sélecteur de couleur =
RVE
"1 Rouge 37 =
| Vert 23 —
71 Bleu 211 =
Hex 2 25175k
TSE
i@ Teinte 252" I3
() Saturation %
I
() Brillance 6%
CMIN
Cyan 60% %
. Magenta 5% (=
Jaune 0% =
’ = l ’ oK ] ’ Annuler

Figure 31 : Editer une couleur

Vous pouvez ici sélectionner une couleur en cliquant dans les zones de couleurs (un clic dans la
barre verticale permet de se positionner dans une tonalité approximative, et un clic dans la zone
carrée permet de choisir une couleur précise), ou en saisissant des valeurs dans la partie droite de
la boite de dialogue, pour les paramétres RVB, TSB (Teinte, Saturation, Brillance) ou CMJN.

Les zones de couleur du cbété gauche sont directement reliées aux champs de saisie du c6té droit ;
si vous sélectionnez une couleur dans les zones de couleur, les valeurs sont mises a jour
instantanément. Les deux zones de couleurs qui forment une barre horizontale affichent la couleur
sélectionnée a droite et sa nouvelle définition & gauche.

Modifiez les composants de la couleur comme vous le souhaitez et appuyez sur OK pour sortir de
la boite de dialogue.

Vous pouvez incorporer les couleurs dans le document en cochant I'option Incorporer. Vous
pouvez également enregistrer la liste des couleurs dans un fichier ayant comme extension .soc.

Vous pouvez également créer des couleurs personnalisées avec Outils > Options
Astuce > LibreOffice > Couleurs. Les couleurs ainsi créées sont disponibles pour tous
les documents dans tous les modules de LibreOffice.

Créer des dégradés personnalisés

Vous pouvez créer des dégradés personnalisés, ou modifier des dégradés existants, dans l'onglet
Dégradés de la boite de dialogue Remplissage (Figure 32).
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Remplissage

Remplissagelﬂmbre |TransparenceICouleurs|Dégradés |Hachure|Eitmaps|

Propriétes
Type

Angle

Bordure

De

Figure 32 : Créer un dégradé
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[ Modifier...
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Il est recommandé de conserver les dégradés prédéfinis tels quels et de les utiliser plutdt comme
point de départ pour créer de nouveaux dégradés, en modifiant les couleurs de départ et d'arrivée

par exemple.

Il existe plusieurs types de dégradés, comme le montre la Figure 33. Les paramétres du dégradé

sont décrits Tableau 2 : certains paramétres seront indisponibles selon le type choisi.

]

Linéaire

Radial

Quadratique

Axial

Ellipsoide

Carré

Figure 33 : Types de dégradés

Créer de nouveaux remplissages

24



Tableau 2. Propriétés du dégradé

Propriété Signification

Centre X Pour les types Radial, Ellipsoide, Carré et Quadratique, positionne le
centre du dégradé sur I'axe X, en pourcentage de la largeur de l'objet.

Centre Y Pour les types Radial, Ellipsoide, Carré et Quadratique, positionne le
centre du dégradé sur I'axe Y, en pourcentage de la hauteur de I'objet.

Angle Pour les types Linéaire, Axial, Ellipsoide, Carré et Quadratique, spécifie
I'angle de I'axe du dégradé par rapport a I'axe horizontal.

Bordure Spécifie le pourcentage de I'axe du dégradé a partir duquel le dégradé
commence (0 % : au début de I'axe ; 100 % : a la fin de I'axe).

De Indique la couleur de départ du dégradé. Le pourcentage correspond a
I'intensité de la couleur, de 0 % pour le noir a 100 % pour l'intensité
maximale.

A Indique la couleur d'arrivée du dégradé. Le pourcentage correspond a
l'intensité de la couleur, de 0 % pour le noir & 100 % pour l'intensité
maximale.

Pour créer un nouveau dégradé, spécifiez son type et ses attributs. Cliquez sur Ajouter et
saisissez son nom, puis cliquez sur OK. Le dégradé est ajouté dans la liste déroulante.

Pour modifier un dégradé, sélectionnez-le dans la liste déroulante. Spécifiez son nouveau type et
ses nouveaux attributs, puis cliquez sur Modifier.

Vous pouvez enregistrer la liste des dégradés dans un fichier ayant comme extension .sog.

Modifier le dégradé de remplissage d'un objet

Vous pouvez modifier certains attributs du dégradé de remplissage d'un objet sans définir de
dégradé personnalisé. Pour ceci, faites afficher la barre d'outils Mode (Figure 34).

Mode
Codwvdd W

Figure 34 : Barre d'outils Mode

Sélectionnez un objet rempli avec un dégradé et cliquez sur l'icbne Dégradé ..* L'axe du dégradé
apparait en pointillés avec, a chacune de ses extrémités, un carré de la couleur correspondante
(Figure 35). Vous pouvez alors déplacer chacun de ses points pour obtenir le dégradé que vous
souhaitez. Les valeurs des propriétés de l'onglet Dégradés de la boite de dialogue Remplissage
sont mises a jour, mais ne sont pas enregistrées comme propriétés du dégradé de la liste
déroulante. Il n'est pas possible de déplacer le point de départ de I'axe d'un dégradé de type Axial.

&

= hl B

Figure 35 : Effet du déplacement de 'axe du dégradé
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Créer des hachures personnalisées

Vous pouvez créer des hachures personnalisées, ou modifier des hachures existantes, dans
l'onglet Hachure de la boite de dialogue Remplissage (Figure 36).

Remplissage (5]
Remplissage |Ombre |Transparence | Couleurs |Dégradés Hachure [Bitmaps
Propriétes
Espacement Moir 0 degré | Ajouter... |
010cm = [ Moir 45 degrés
! = Frma] Moir -45 degrés | Modifier... |
Angle (] Meirs0 degrés —
- - 2 Rouge double incliné 45 d
0 degres b Rouge double incling 0 de
Bleu double incling 45 dec | : . |
LA A i Bleu double incling 0 degr LPPIMET.
~ P EEE Bleu triple incling 30 degre
[ | Moir45 degrés de largeue
& { i —
@8]
Type de ligne
|Simp|e IE"
Couleur de ligne
|- Moir |E||

Figure 36 : Créer une hachure de remplissage

Il est recommandé de conserver les hachures prédéfinies telles quelles et de les utiliser plutdt
comme point de départ pour créer de nouvelles hachures. Les parametres d'une hachure sont
décrits Tableau 3.

Tableau 3. Propriétés d'une hachure

Propriété Signification
Espacement Spécifie I'espacement entre deux lignes de hachure.
Angle Spécifie I'angle des lignes de hachure par rapport a I'axe horizontal.

Vous pouvez également utiliser la miniature en dessous pour
spécifier un angle multiple de 45 degrés.

Type de ligne Indique Il'utilisation d'une ligne simple ou de lignes croisées ou triples
comme motif de hachure.

Couleur de ligne Permet de sélectionner la couleur de la ligne de hachure dans la liste
déroulante.

Pour créer une nouvelle hachure, spécifiez ses attributs. Cliquez sur Ajouter et saisissez son nom,
puis cliquez sur OK. La hachure est ajoutée dans la liste déroulante.

Pour modifier une hachure, sélectionnez-la dans la liste déroulante. Spécifiez ses nouveaux
attributs, puis cliquez sur Modifier.

Vous pouvez enregistrer la liste des hachures dans un fichier ayant comme extension .soh.
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Créer et importer des images bitmap

Vous pouvez ajouter (importer) de nouvelles images de remplissage ou créer vos propres motifs,
dans l'onglet Bitmaps de la boite de dialogue Remplissage (Figure 37).
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Figure 37 : Créer un nouveau motif bitmap

Pour créer un motif de remplissage :

1) Sélectionnez l'image bitmap Vide dans la liste déroulante pour activer I'éditeur de motif.
2) Choisissez les couleurs de premier plan et d'arriére-plan dans les listes déroulantes.

3) Dessinez le motif en cliquant dans un carré (pixel) de la grille de I'éditeur de motif, avec le
bouton gauche de la souris pour lui attribuer la couleur de premier plan et avec le bouton
droit pour lui attribuer la couleur d'arriere-plan. Vous pouvez contréler le résultat obtenu
dans l'apercu.

4) Cliquez sur Ajouter, saisissez le nom de votre motif et cliquez sur OK pour ajouter le motif
dans la liste déroulante des images bitmap.

Vous pouvez également importer une image existante en cliquant sur Importer, en choisissant le
fichier image et en saisissant son nhom.

Vous pouvez enregistrer la liste des images bitmap dans un fichier ayant comme extension .sob.

Utiliser les styles

Supposez que vous vouliez appliquer le méme remplissage et la méme largeur de bordure et de
ligne a un ensemble d'objets. Cette procédure répétitive peut étre simplifiée par I'utilisation des
styles. Cette fonctionnalité vous permet de définir un format modéle (un style) et ensuite de
I'appliquer a plusieurs objets. Pour plus d'informations sur les styles, voir le Chapitre 6
(Introduction aux styles) du Guide Writer.

Cliquez sur l'icbne Styles et formatage GE de la barre d'outils Ligne et remplissage ou appuyez
sur la touche F11 pour ouvrir la boite de dialogue Styles et formatage, puis cliquez sur l'icbne
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Styles d'images = en haut & gauche (Figure 38). La liste des styles utilisables pour les objets
graphigues apparait.

Styles et formatage =]
Corps de texte

Corps de texte justifie

Ligne de cote

Objet avec fleche

Ohjet avec ombre

Objet sans remplissage

Retrait de premiére ligne

Standard

Texte

Titre

Titrel

Titred

Titre3

Titred

Titres

Tous les styles IE"

Figure 38 : Boite de dialogue Styles et formatage

Styles d'image

Les styles d'image contiennent plusieurs attributs regroupés dans les onglets suivants (Figure 39) :

L'onglet Gérer contient un résumé du style et sa position hiérarchique.

L'onglet Ligne contient les propriétés de formatage des lignes des objets graphiques : voir
"Propriétés de la ligne" page 9.

L'onglet Remplissage contient les propriétés de formatage du remplissage des objets
graphigues : voir "Onglet Remplissage" page 15.

L'onglet Ombrage contient les propriétés d'ombrage des objets graphiques : voir "Ombre"
page 19.

L'onglet Transparence contient les propriétés de transparence des objets graphiques : voir
"Transparence" page 20.

Les onglets Police et Effets de caractére contiennent les propriétés des caractéres des
textes : voir Chapitre 9 (Ajouter et formater des textes).

Les onglets Retraits et espacement, Alignement et Tabulations contiennent les propriétés
des paragraphes des textes : voir Chapitre 9 (Ajouter et formater des textes).

Les onglets Texte et Animation de texte contiennent les propriétés des textes des objets
graphigues : voir Chapitre 9 (Ajouter et formater des textes).

L'onglet Cotation contient les propriétés des lignes de cote : voir Chapitre 11 (Techniques
avancees).
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* L'onglet Connecteur contient les propriétés des connecteurs : voir Chapitre 8 (Connecteurs
et organigrammes).

Lorsque vous appliquez un style d'image, tous les attributs de tous les onglets
Attention s'appliquent a I'objet sélectionné, méme si vous n'avez sélectionné que son texte. Un
style d'image Draw est donc différent d'un style de paragraphe Writer dont les
A attributs ne concernent que le texte, et ce bien que les noms des styles soient
identiques.

Styles d'image liés

Les styles d'image permettent I'héritage. En d'autres termes, un style peut étre lié & un autre style
(parent) afin d'hériter de ses attributs de formatage. Vous pouvez utiliser cette fonctionnalité pour
créer des familles de styles.

Par exemple, si vous avez besoin de plusieurs rectangles qui ne different que par leur couleur de
remplissage, la meilleure facon de procéder est de définir un style générique pour la forme
rectangle qui définit les bordures, le type de remplissage, la police, etc. Puis créez des styles liés a
ce premier style, qui ne difféerent que par la couleur de remplissage. Ainsi, si vous n'avez besoin de
modifier que I'épaisseur de la bordure, vous pouvez ne le faire que dans le style parent, et les
autres styles liés vont changer en conséquence.

Créer des styles d'image

Assurez-vous que l'icone Styles d'images est sélectionnée.

En utilisant la boite de dialogue Styles d'images
1) Sélectionnez, si vous le souhaitez, le style a partir duquel vous voulez créer un nouveau
style.

2) Faites un clic droit et choisissez Nouveau dans le menu contextuel pour ouvrir la boite de
dialogue Styles d'images (Figure 39). Si vous aviez sélectionné un style, vous allez lier le
nouveau style a ce style de départ. Si vous n'avez pas sélectionné de style, le nouveau
style sera lié au style Standard.

Styles d'images (3]

Animation de texte Cotation Connecteur Alignement Tabulatiocns

Gérer |Ligne | Remplissage | Ombrage | Transparence | Police | Effets de caractéres | Retraits et espacement | Texte

Style
MNom Sans noml
Lié 3 \Standard B3

Catégorie |T|:n_|5 les styles

Figure 39 : Boite de dialogue Styles d'images

3) Attribuez au nouveau style un nom significatif.

4) Utilisez les différents onglets de la boite de dialogue Styles d'images pour fixer le format du
nouveau style.

5) Cliquez sur OK pour enregistrer le nouveau style.
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En utilisant I'objet sélectionné
Vous pouvez créer un nouveau style a partir d'un objet déja formaté, qui peut étre un texte ou un
objet graphique :
1) Sélectionnez I'objet que vous voulez utiliser.
2) Ouvrez la boite de dialogue Styles et formatage et cliquez sur l'icone Nouveau style a
partir de la sélection B en haut a droite.

3) Dans la boite de dialogue Créer un style qui s'ouvre, saisissez le nom du nouveau style. La
liste affiche les styles personnalisés disponibles.

4) Cliquez sur OK pour enregistrer le nouveau style.
Il est également possible de créer un nouveau style en faisant glisser un objet :

1) Ouvrez la boite de dialogue Styles et formatage.
2) Sélectionnez l'objet que vous voulez utiliser et maintenez le bouton de la souris enfoncé

jusqu'a ce que la forme du pointeur change ( %3 ). Si le changement n'intervient pas,
déplacez légérement la souris.

3) Pour annuler l'opération sans déplacer I'objet, appuyez sur la touche Echap.
4) Faites glisser I'objet dans la fenétre Styles et formatage.

5) Dans la boite de dialogue Créer un style qui s'ouvre, saisissez le nom du nouveau style. La
liste affiche les styles personnalisés disponibles.

6) Cliquez sur OK pour enregistrer le nouveau style.

Modifier un style d'image

Dans la boite de dialogue Styles et formatage, faites un clic droit sur le style d'image que vous
voulez modifier et choisissez Modifier dans le menu contextuel. La boite de dialogue qui s'ouvre
est la méme que celle pour créer un style d'image. Faites les modifications voulues, puis cliquez
sur OK pour les enregistrer.

Mettre a jour un style d'image a partir d'une sélection

Pour mettre a jour un style d'image a partir de I'objet sélectionné, choisissez le style d'image dans
la boite de dialogue Styles et formatage que vous voulez mettre a jour, puis cliquez sur l'icbne

Actualiser le style = qui se trouve en haut a droite. Cette méthode applique directement, et
sans demande de confirmation, les attributs de I'objet sélectionné au style choisi ; la modification
ne peut étre annulée. Vous pouvez aussi choisir Editer le style d'objet dans le menu contextuel
d'un objet sélectionné : le dialogue s'ouvre et toutes les options sont accessibles.

Appliquer des styles d'image

Vous pouvez appliquer un style d'image de deux facons a partir de la boite de dialogue Styles et
formatage :

* Sélectionnez l'objet et double-cliquez sur le nom du style que vous voulez lui appliquer.

* Cliquez sur l'icbne Mode Tout remplir @'. Le curseur de la souris change de forme.
Positionnez-le sur I'objet dont vous voulez modifier le style et cliquez sur le bouton gauche.

Lorsque le mode Tout remplir est actif, un clic droit n‘importe ou dans le document

Attention o . . C i
annule la derniére action de ce mode. Faites attention a ne pas faire
A involontairement de clic droit et ainsi d'annuler des actions que vous voudriez
conserver.
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En bas de la boite de dialogue Styles et formatage se trouve une liste déroulante.
Astuce Vous pouvez choisir d'afficher tous les styles ou seulement les styles appliqués ou
les styles personnalisés.

Supprimer des styles d'image

Vous ne pouvez pas supprimer un style prédéfini de Draw, méme si vous ne l'avez pas utilisé.
Vous ne pouvez supprimer que les styles personnalisés. Cependant, avant de le faire, vérifiez que
le style d'image ne soit pas utilisé. Si c'est le cas, remplacez-le par un style de substitution.

Pour supprimer un style d'image personnalisé, faites un clic droit sur le style dans la boite de
dialogue Styles et formatage et choisissez Supprimer dans le menu contextuel. Un message de
confirmation apparaitra.

Appliquer des effets spéciaux

Un certain nombre d'effets spéciaux peuvent étre appliqués a un objet dans Draw. Plusieurs
d'entre eux sont disponibles dans la barre d'outils Mode (Figure 40). Si cette barre d'outils n'est
pas visible, allez dans Affichage > Barre d'outils > Mode.

Mode
R T W
Figure 40 : Barre d'outils Mode

Pour les informations sur la rotation des objets, voir Chapitre 3 (Manipuler les objets et les points
des objets). Pour les informations sur la révolution des objets en 3D, voir Chapitre 7 (Manipuler
des objets 3D).

L'utilisation de I'outil Transparence est expliquée dans "Modifier la transparence d'un objet" page
21.

L'utilisation de I'outil Dégradé est expliquée dans "Modifier le dégradé de remplissage d'un objet"
page 25.

Retourner des objets

La méthode la plus simple pour retourner un objet est de le sélectionner, de faire un clic droit et de
choisir Refléter > Verticalement ou Refléter > Horizontalement dans le menu contextuel. Vous
pouvez trouver également ces commandes dans le menu Modifier.

L'outil Retourner de la barre d'outils Mode peut aussi étre utilisé. Cet outil vous permet de maodifier
la position et I'angle de retournement (Figure 41).

1) Cliquez sur I'objet graphique a retourner. Les poignées de sélection apparaissent.

2) Cliquez sur l'icobne Retourner [%. L'axe de symétrie apparait sous la forme d'une ligne de
pointillés au milieu de I'objet. L'objet sera retourné autour de cet axe.

3) Déplacez une ou les deux extrémités en les faisant glisser avec le bouton de la souris pour
déterminer l'orientation de l'axe de symétrie.

4) Placez le curseur de la souris au-dessus d'une poignée de sélection de I'objet afin que sa
forme change.

5) Cliquez et faites glisser le curseur de l'autre c6té de I'axe de symétrie. Une image fantbme
de I'objet retourné apparait.

6) Relachez le bouton de la souris et |'objet retourné apparaitra.
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Si vous gardez appuyée la touche Maj durant le déplacement de I'axe de symétrie, I'angle de cet
axe est limité aux multiples de 45 degrés. Ceci est le comportement par défaut de la touche Maj.
Cependant, si l'option Lors de la rotation de la section Enclencher de Outils > Options >
LibreOffice Draw > Grille est cochée, I'action de la touche Maj est inversée. L'angle de I'axe est
limité aux multiples de 45 degrés, a moins que la touche Maj ne soit appuyée.

Pour obtenir I'effet miroir d'un objet graphique, dupliquez-le, puis retournez la copie.

= E:} =
‘ . ‘ Forme de départ
s . _  avec axe de symétrie
© ] 5
@ a o .
\\ K ’ Forme d'arrivée
m | - .
B B8 ‘ ‘@3 ‘
Forme au cours {} 4

du déplacement |

Figure 41 : Retournement d'un objet

Déformer un objet

Sélectionnez I'objet a déformer et cliquez sur I'icbne Déformer I:f?. Un message vous demandera
de convertir I'objet en courbe si ce n'est pas déja fait ; cliquez sur Oui pour pouvoir continuer.
Cliquez et faites glisser une poignée de sélection pour déformer l'objet (Figure 42). L'effet sera

différent selon la poignée sélectionnée.

Figure 42 : Déformer un objet
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Positionner sur le cercle (en perspective)

Sélectionnez I'objet a déformer et cliqguez sur I'icbne Positionner sur le cercle (en perspective)

o

% Un message vous demandera de convertir I'objet en courbe si ce n'est pas déja fait ; cliquez
sur Oui pour pouvoir continuer. Cliquez et faites glisser une poignée de sélection pour déformer
l'objet (Figure 43).
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Figure 43 : Positionner un objet sur un cercle (en perspective)

Positionner sur le cercle (incliner)

u]
Sélectionnez I'objet & déformer et cliquez sur lI'icone Positionner sur le cercle (incliner) % un
message vous demandera de convertir I'objet en courbe si ce n'est pas déja fait ; cliquez sur Oui
pour pouvoir continuer. Cliquez et faites glisser une poignée de sélection pour déformer I'objet
(Figure 44).
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Figure 44 : Positionner un objet sur un cercle (incliner)
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